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Intended Audience 
This installation and getting started guide is intended to be used by experienced  
IT professionals who are familiar with software installations and configurations. Additionally, 
users of this installation guide should be familiar with the Microsoft® Windows operating 
system and basic database administration.  
 

Product Support 
Digitech Systems, Inc. takes great pride in providing software that is extremely simple to use, 
feature-rich, and flexible both in architecture and in integration capabilities. If, for some 
reason, you experience any difficulty, please do not hesitate to contact us to experience our 
legendary customer service toll free at (877)374-3569 or direct at (402)484-7777. 
Additionally, you may contact us at support@digitechsystems.com. Our technical support 
staff is available to serve you between the hours of 8:00 AM and 6:00 PM Central Time. 

Digitech Systems’ product features and enhancements are driven by you, our customer. If you 
have an idea for a future product feature or enhancement, please send an e-mail to 
dev@digitechsystems.com. 

 

Additional Help Resources 
In addition to our legendary technical support staff, we also offer web-based resources to help 
answer your questions and resolve your issues. 

Help on the Web 
MyDSI is an interactive tool for all Digitech Systems customers. Log in to MyDSI at 
http://mydsi.digitechsystems.com to download product updates, license purchased 
software, view support contract renewals, and check the status of your software support 
cases and requests. 

 

User Forums 
Log in to the User Forums at http://forums.digitechsystems.com to exchange answers 
and ideas with other users in our moderated community. 

 

Knowledge Base 
Log in to search our extensive Knowledge Base at http://kb.digitechsystems.com for 
articles on all Digitech Systems products. 

 

mailto:support@digitechsystems.com�
mailto:dev@digitechsystems.com�
http://mydsi.digitechsystems.com/�
http://forums.digitechsystems.com/�
http://kb.digitechsystems.com/�
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Documentation 
For documentation on the features and functions of the PaperVision Enterprise application, 
refer to the Online Help file, found by opening the application’s Help menu > Help 
Topics. 

 

System Requirements 
The following table outlines the minimum software requirements for PaperVision  
Enterprise and its optional components. 

 
Minimum System Requirements 

Operating Systems 

 

Windows XP SP2 or later (both 32- and 64-bit operating 
systems supported) required for the following 
components: 

• PaperVision Administration Console 

• PaperVision Enterprise  

• PaperVision Automation Service (not required) 

• PaperVision.net Enterprise Browser Plug-Ins (not 
required)* 

• PaperVision Web/Application or Authentication 
Gateway Server (not required)* 

* Both components require Internet Information 
Server (IIS) 5.0 or later 

.NET Framework Version 3.5 SP1 or later 

Microsoft® SQL Server® SQL Server 2000 or later 

Note: Optionally, you can install Microsoft SQL Server 

2005 Express Edition during the PaperVision Enterprise 
installation. 

Internet Browser  Internet Explorer® 6 SP2 or later 

Mozilla Firefox® 3.5 or later 

IMPORTANT: The Mozilla Firefox browser is not 
compatible with the Document Viewer plug-in. 

Screen Resolution SVGA Monitor (1024 x 768 or higher recommended) 
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PaperVision Enterprise Terminology 
To fully understand PaperVision Enterprise, the following key terms are used throughout the 
installation and application. 
 

Administrators 
PaperVision Enterprise supports the following types of administrators: 

• Global administrators can control every aspect of configuration for the PaperVision 
Enterprise system, including configurations for all entities. However, they cannot 
access the documents in a project, as a system (entity) administrator can. 

• System administrators are entity administrators. They can administrate a single entity 
and have access to all functionality in all projects for that entity. However, system 
administrators cannot assign the entity's data group, full-text, migration and batch 
paths, for example, that a global administrator can assign. 

• Workflow administrators are able to design and configure workflows within an entity. 
They can configure workflow definitions for any project and view workflow history 
and workflow status reports, but they have no access to documents or functions in any 
projects unless a system administrator explicitly grants them access. If they do have 
access to view documents within a project, workflow administrators can create 
workflow instances for a particular document and view its workflow status. 

• Capture administrators can define Capture Jobs for use with the PaperVision Capture 
product. Capture administrators have no administrative capabilities in PaperVision 
Enterprise. 

 

Data Group 
A data group is a set of documents and their index values. A data group can contain one or 
more documents, and those documents can be grouped into one or many projects. A data 
group holds information for only a single client, but it can contain an unlimited number of 
projects. Typically, a data group only contains documents for one project, as this makes 
organization easier. 

 

Documents 
Documents contain the individual pages or images for a given set of index values. When 
document grouping is enabled in System Settings > User Options, documents are grouped 
per page results. By default, 100 documents appear per page of search results in 
PaperVision Enterprise. 
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Entity 
An entity is a body such as a corporation or organization. Each entity is autonomous and 
administers its own projects, users, groups, workflows, security policies, etc. An entity 
never shares elements with other entities, and you cannot switch between entity IDs after 
you log in. You or your administrator can limit access to specific projects, functionality, 
and documents within your entity. 

In general, most users (including users at large enterprise installations) use only a single 
entity. Only a few special circumstances require more than one entity: 

For example, you might see more than one entity in a hosting environment where an on-
demand provider is hosting data for multiple companies and each company wants to be 
able to administrate itself and its users. You might also see more than one entity in a large 
enterprise consisting of different departments that want the ability to administrate 
themselves separately from other departments without involving a central IT organization.  

 

Entity ID 
An entity ID is a unique number that identifies each entity. Each entity is autonomous; you 
cannot change your entity ID after you log in and cannot work across entities. 

 

Index Values 
Document index fields contain values that enable you to identify key elements of 
documents within a project during the capture process. You then use these index field 
values to search for and retrieve documents in PaperVision Enterprise. When you enter an 
index value to perform a search for a document, the application compares the value you 
entered against your database tables and retrieves documents that meet your specific 
criteria.  

 
PaperVision Administration Console 

The PaperVision Administration Console provides administration and configuration 
capabilities. 

 

PaperVision Authentication Gateway 
The PaperVision Authentication Gateway includes the web interface for integrated 
Windows-based authentication to the PaperVision Enterprise Server (single sign-on).  
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PaperVision Automation Server 
The PaperVision Automation Server runs as a Microsoft Windows service that performs 
automated operations at specified time intervals. Examples of work performed by the 
PaperVision Automation Server include importing data, workflow management, records 
retention and destruction, and report processing.  

 
PaperVision Distribution Assistant 

The PaperVision Distribution Assistant embeds a simple viewer in distribution media with 
migrated documents. 

 

PaperVision Enterprise Local Client 
The PaperVision Enterprise Local Client application provides the same client features and 
functionality provided by the PaperVision Enterprise Server without requiring a web 
server. Users can perform operations such as document viewing, searching, indexing, and 
other document manipulation operations.  

 

PaperVision Enterprise Server 
The PaperVision Enterprise Server provides the web interface for user access. 

 

Project 
A project is a logical grouping of documents based on a common indexing schema. For 
example, ABC Company has three projects: Human Resources, Accounts Receivable, and 
Sales. 

• The Accounts Receivable project contains billing, purchase order, and invoice 
information. 

• The Human Resources project contains Human Resources records, such as 
employee records and health insurance information. 

• The Sales project contains prospect and client information. 

Each of these projects is a separate logical grouping within the ABC Company entity. 
Projects support up to 200 named index fields. Project names must be unique within an 
entity, but you can create an unlimited number of projects. 
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This chapter describes the steps involved during the installation of PaperVision  
Enterprise Server on your computer. You must be designated as an administrator  
in order to install any of the PaperVision Enterprise setup types. Before you begin the 
installation, you may want to look at Appendix C – System Architecture in the 
PaperVision Enterprise Administration and System Architecture Reference Guide to 
help you assess what configuration options are available with PaperVision Enterprise. 

Note: 
PaperVision Enterprise is intended to be installed using administrative privileges. If 
UAC is enabled during the installation of PaperVision Enterprise, some operations 
may not function properly.  

If UAC is enabled and you are not logged into Microsoft Windows as the machine’s 
administrator, a UAC prompt will appear each time you launch the PaperVision 
Administration Console and ask you to allow the PaperVision Administration 
Console to make changes to the computer. 

 

User Account Control Prompt 

 

PaperVision Enterprise Installation and Configuration Wizard 
The installation and setup of PaperVision Enterprise requires that you follow the instructions 
on every screen. You can click the Back or Next buttons to move backward and forward 
through the screens. You can click the Cancel button to exit and close the Installation or 
Setup Wizard. Additionally, the Skip button is available on certain screens if specific 
components have already been configured in previous versions of PaperVision Enterprise.
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Installing PaperVision Enterprise Server 
The following instructions describe the default PaperVision Enterprise Server installation type 
that installs all Server, Administrative, and Automation features. If you have not already 
established a database connection, you can optionally install Microsoft SQL Server 2005 
Express Edition. Instructions describing the installation of PaperVision Enterprise Stand-
Alone that provides all Administrative, Automation, and Local Client features (document 
viewing, searching, and manipulation operations; workflow tasks, etc.) begin in Chapter 3. 

 

To install PaperVision Enterprise Server: 
1. From the PaperVision Enterprise installation DVD, launch the PaperVision 

Enterprise.msi. The Welcome to PaperVision Enterprise screen appears. 

 
Welcome to PaperVision Enterprise 
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2. Click Next, and the License Agreement screen appears. 

 
License Agreement 
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3. If you accept the terms of the License Agreement, click Next, and the Setup Type 
screen appears. If you decline the terms, the installation will terminate.  

 
Setup Type 

4. In the Setup Type screen, select the PaperVision Enterprise Server setup type. This 
setup type installs all Server, Administration, and Automation features. 
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5. After selecting the setup type, click Next, and the Microsoft® SQL Server® 2005 
Express Edition screen appears.  

 
Microsoft® SQL Server® 2005 Express Edition 

6. If you have already established a database connection, select No, and then proceed to 
step 8 on page 14. 

7. If you would like to install Microsoft SQL Server, select Install Microsoft SQL 
Server 2005 Express Edition, and then click Next to proceed to the next step. 
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8. Click Next and the Ready to Install the Program screen appears. 

 
Ready to Install the Program 

  



Chapter 2 – PaperVision Enterprise Server Installation  

PaperVision® Enterprise Installation and Getting Started Guide                                                15 

9. To proceed with the installation, click Install. A progress message will appear for a 
few minutes. 

 
Installing PaperVision Enterprise 
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10. Once PaperVision Enterprise has been successfully installed, the InstallShield 
Wizard Completed screen appears. Click Finish to launch the PaperVision Enterprise 
Configuration Wizard. 

 
InstallShield Wizard Completed 
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Configuring PaperVision Enterprise Server 
Once you have successfully installed PaperVision Enterprise Server, you are presented with a 
configuration wizard that is designed to simplify the setup process. 

To configure PaperVision Enterprise Server: 
1. To begin the configuration process, click Next, and the Welcome – PaperVision 

Enterprise Configuration screen appears. 

 
Welcome – PaperVision Enterprise Configuration  
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2. Click Next. The Configure PaperVision Enterprise Server Site screen appears.  

 
Configure PaperVision Enterprise Server Site 

Note:  

Depending on your operating system, some web site properties may not be 
available for configuration in this screen. 

3. To automatically configure and create the IIS web site used by the PaperVision 
Enterprise Server, select Configure Web Site.  

Note:  

If a PaperVision Enterprise web site already exists, you can press Skip and 
proceed to step 11 on page 20. 

4. Enter the IIS Web Site Description, which reflects how the name will appear in the 
list of IIS web sites. 

5. Enter the IIS Web Site IP Address. You can either select All Unassigned IP 
addresses or select a specific IP address from the drop-down list.  
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• If you select All Unassigned IP Addresses, you can either type in the machine 
name (e.g., http://<MachineName>/Default.aspx) or IP address to browse to the 
site. 

• If you select a specific IP Address from the drop-down list, then you must type 
in the specific IP address (e.g., http://10.150.10.10/Default.aspx). 

6. Enter the Web Site TCP Port that will be used to communicate with IIS. If the 
Default Web Site in IIS already uses the specified port, you must complete one of the 
following options: 

a. Specify another port number (e.g., 8086).  

b. Delete the Default Web Site if it has not already been configured.  

c. In IIS, stop the Default Web Site by right-clicking it, and selecting Stop from 
the context menu. However, if you want to start the Default Web Site at a later 
time, you will need to change its TCP Port. 

d. Use the server name and a different IP address. 

7. Enter the IIS Web Site Host Header, which allows multiple URL addresses to 
connect to the same site or to segregate web sites. Host headers may also be used 
when two web sites share the same port. 

8. Enter the IIS Account User Name used for anonymous access. You must enter the 
name using one of the following formats: 

a. <DomainName>\<UserName>  

b. <MachineName>\<Username>  

Note:   
The specified account must have the Windows Log On as a Service user 
right enabled. 

9. Enter the IIS Web Site Account Password, and then confirm the password. 
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10. Click Next, and the Configure PaperVision Authentication Gateway Site screen 
appears.  

 
Configure PaperVision Authentication Gateway Site 

11. To automatically create and configure the authentication gateway in IIS, select 
Configure Web Site. 

Note:  

If the PaperVision Authentication Gateway Site already exists, you can press 
Skip and proceed to step 17 on page 22. 

12. Enter the Web Site Description, which reflects how the name will appear in the list of 
IIS web sites. 
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13. Enter the Web Site IP Address. You can either select All Unassigned IP Addresses 
or select a specific IP address from the drop-down list.  

• If you select All Unassigned IP Addresses, you can either type in the web site 
domain name or IP address to browse to the site 
(e.g., http://PaperVisionDomainName/Default.aspx). 

• If you select a specific IP Address from the drop-down list, then you must type 
in the specific IP address (e.g., http://10.150.10.10/Default.aspx). 

14. Enter the Web Site TCP Port that will be used to communicate with IIS. If the 
Default Web Site in IIS already uses your specified port, you must complete one of the 
following options: 

a. Specify another port number (e.g., 8086).  

b. Delete the Default Web Site if it has not already been configured.  

c. In IIS, stop the Default Web Site by right-clicking it, and selecting Stop from 
the context menu. However, if you want to start the Default Web Site at a later 
time, you will need to change its TCP Port. 

d. Use the server name and a different IP address. 

15. Enter the Web Site Host Header, which allows multiple URL addresses to connect to 
the same site or to segregate web sites. Host headers are also used when two web sites 
share the same port. 
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16. Click Next, and the Configure PaperVision Automation Service screen appears.  

 
Configure PaperVision Automation Service  

17. The PaperVision Automation Service is a Microsoft Windows service that performs 
automated tasks and operations at a specified time interval. Select the user account 
under which the PaperVision Automation Service will execute. 

• The Local System Account requires no additional user name or password 
information. However, the Local System Account generally does not have 
access to network shared drives and other directories on the computer. As 
such, it may be necessary to change the account the service is using. A 
confirmation message will prompt you whether to save your changes (if you 
changed the account settings) and continue with the installation.  

Note:  

If you select No, the installation will not proceed. See Appendix C 
for information on changing the Windows service account. 



Chapter 2 – PaperVision Enterprise Server Installation  

PaperVision® Enterprise Installation and Getting Started Guide                                                23 

• This Account enables you to select the Windows user account that will have 
security rights to perform all PaperVision Automation Service functions such 
as reading, writing, and deleting files. Enter a user name and password. 

Note:   

The specified account must have the Windows Log On as a Service 
user right enabled. 

18. Verify that the account settings are correct, and then click Next.  

• If you are installing Microsoft SQL Server 2005 Express Edition, the Install 
Microsoft® SQL Server® 2005 Express Edition screen appears. Proceed to 
the next step.  

• If you are not installing SQL Server, proceed to step 22 on page 25. 

 
Install Microsoft® SQL Server® 2005 Express Edition   
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19. Enter a password for the SQL Server System Administrator.  

Note:  

The SQL Server System Administrator’s password must meet strong 
password policy requirements. For more information, see the Microsoft 
Developer’s Network web site: 

http://msdn.microsoft.com/en-us/library/ms143705(SQL.90).aspx 

20. Click the Install button to begin the SQL Server 2005 Express Edition installation, 
which will take several minutes to complete. The Install Microsoft SQL Server 2005 
Express Edition screen appears after installation. 

 
Install Microsoft® SQL Server® 2005 Express Edition (successfully installed) 

http://msdn.microsoft.com/en-us/library/ms143705(SQL.90).aspx�
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21. After you have been notified that the SQL Server was successfully installed, click 
Next, and the PaperVision SQL Server Connection Information screen appears. 

 
PaperVision SQL Server Connection Information 

22. Enter the Server IP Address/Name where the database resides, which can be an IP 
address or machine name. 

23. Enter the Database Name that will be used to share data with PaperVision Enterprise. 

24. Enter the User Name that has permissions to create new users and add new data. The 
default user name is derived from the System Administrator account specified in step 
21. If you do not want to use the System Administrator account, enter the name of a 
user that can be created automatically and granted the appropriate permissions in SQL 
Server. 
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25. Enter the Password that is linked to the user created in the previous step. By default, 
the System Administrator’s password is used. If you created a new user (instead of 
using the System Administrator) enter a password for the new user. 

Note:   

If you leave the User Name and Password fields blank, the database 
connection will use Windows Authentication credentials. Entering a user 
name and password for the database will supercede the Windows 
Authentication credentials. 

26. Confirm the password specified in the previous step. 

27. Select the Connection Type, which defaults to TCP/IP. Available connection types 
include Named Pipes, IPX/SPX, Multiprotocol, and Banyan Vines. 

28. If you chose the TCP/IP connection, enter the port number. 

29. Select the Create New Database option if the specified database name does not 
already exist. The new database will be automatically created in SQL Server. 

30. Select the Create New User option if the specified user does not already exist. The 
new user will be automatically created in SQL Server and granted access to the 
database.  

Note:  
If you select this option, a SQL Login prompt will appear. Enter the user 
name and password for the account that has permission to create new users. 
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31. Click Next, and the PaperVision Licensing screen appears.   

 
PaperVision Licensing 

32. To add your purchased license, click the Add License button, and proceed to step 34 
on page 28. 

33. If you want to run PaperVision Enterprise in demonstration mode, click the 30 Day 
Demo License button and proceed to step 39 on page 29. 

Note:  

If you have already added a purchased license of PaperVision Enterprise, you 
cannot add a subsequent demo license. If you want to add a demo license, 
you must add it before any purchased license. The demo license includes one 
license each of the Advanced Admin Pack and Enterprise Workflow and fifty 
Enterprise User licenses. 
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34. In the New License dialog box, enter the license code that was included with your 
product documentation and media.  

 
New License 

35. If the computer has access to the Internet, click the Web Authorization button to 
obtain the license key online.  

36. Or, click the Phone Authorization button and contact Digitech Systems’ Technical 
Support toll-free at (877)374-3569 or direct at (402)484-7777 to obtain your license 
key.  

Note:  

You must provide the serial number and identifier before the license key will 
be provided to you.  

37. In the Obtain Authorization Code dialog box, enter the code, and then click OK. 
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38. Click Next, and the PaperVision Data Storage screen appears.  

 
PaperVision Data Storage 

39. In the PaperVision Data Storage screen, enter the location of the data storage path 
where document and full-text data will be stored, or click the ellipsis button to browse 
to the location. If multiple computers will be accessing this location, it is 
recommended to enter a network-accessible path such as \\SERVER\SHARE. 
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40. Click Next, and the Thank You – PaperVision Enterprise Configuration screen 
appears. 

 
Thank You – PaperVision Enterprise Configuration 

41. Click Finish to close the configuration wizard. You are ready to log into the 
PaperVision Enterprise application.  

  



Chapter 2 – PaperVision Enterprise Server Installation  

PaperVision® Enterprise Installation and Getting Started Guide                                                31 

Configuring PaperVision Gateway Settings 
After PaperVision Enterprise Server has been successfully installed and configured, you must 
configure the PaperVision Authentication Gateway using the PaperVision Gateway Settings 
utility. The PaperVision Gateway Settings application can be accessed by simply selecting the 
icon in Start > Programs > Digitech Systems > PaperVision Gateway Settings. 

Note:  

Refer to Appendix G for further information regarding the remote authentication 
gateway capabilities in PaperVision Enterprise. 

The PaperVision Gateway Settings application allows administrators to enter the encryption 
key and other settings that will be used by the authentication gateway. This application saves 
the settings in an AES-256 bit encrypted file which is specific to the machine on which it was 
created. For security purposes, the created “PVRemoteAuth.XML” file cannot be copied from 
one machine to another – each machine must be used to create its own file.  

 
PaperVision Gateway Settings 
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The following Remote Authentication Gateway settings are available for configuration: 

• Encryption Key Value specifies the encryption key value (not the encryption key 
name) which is identical to that created and selected in the entity security policy as the 
Remote Authentication Gateway Encryption Key. 

• Redirection URL specifies the URL or web page that the user will be redirected to for 
authentication to PaperVision (typically a Login page).  

Some possible examples include: 

Default.ASPX: This URL can be used when the gateway is in the same web site as the 
main PaperVision repository web site. 

Tip: 

To redirect PVESearchURL requests to the PaperVision Authentication Gateway, 
insert the query parameter “searchURL=true” into the Default.aspx URL.  

To view a list of optional PVESearchURL query parameters, append 
“/PVESearchURL.aspx?” to the end of your PaperVision URL Address. 

 

http://myserver/Default.ASPX: This URL can be used when the gateway is in a 
different web site as the main PaperVision repository web site. 

https://login.imagesilo.com/Default.ASPX: This URL can be used to remotely 
authenticate to ImageSilo. 

• Default Entity ID specifies the default entity ID to be used when accessing the 
authentication gateway.  
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Accessing the Authentication Gateway 
Accessing the authentication gateway is as easy as opening your web browser and pointing it to 
the URL of your authentication gateway web site. If you wish to use a non-default entity ID (as 
specified in the PaperVision Gateway Settings), you can specify the ENTID value as shown in 
the following example: 
 

http://myservergw/AutoLogin.ASPX?ENTID=1234 

 
The authentication gateway also includes a DebugUser.ASPX page which is designed to help 
administrators troubleshoot IIS authentication issues by displaying the authorized user 
credentials detected by IIS. 

Note:  
When configuring the Authentication Gateway in PaperVision Tools, do not specify 
the web page name for either the Server URL (e.g., Default.aspx) or Gateway URL 
(e.g., Autologin.aspx) as in the example below:  

 

 
PaperVision Office Tool: Options 
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The following instructions describe a stand-alone installation of PaperVision  
Enterprise that installs all Administrative, Automation, and Local Client features  
(document viewing, searching, and manipulation operations; indexing, workflow tasks, 
destruction lists, etc.). If you have not already established a database connection, you can 
optionally install Microsoft SQL Server 2005 Express Edition that is included on your 
installation media. Contrary to the PaperVision Enterprise Server, the PaperVision Enterprise 
Local Client does not require the use of IIS. The installation and configuration of the 
PaperVision Enterprise Stand-Alone System setup type follows the same general steps as 
described in the previous chapter. 

Note:  

The PaperVision Enterprise Local Client and PaperVision Enterprise Server cannot be 
installed on the same machine. 

To Install the PaperVision Enterprise Stand-Alone System: 
1. From the PaperVision Enterprise installation DVD, launch the PaperVision 

Enterprise.msi. The Welcome to PaperVision Enterprise screen appears. 

 
Welcome to PaperVision Enterprise 
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2. Click Next, and the License Agreement screen appears. 

 
License Agreement 
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3. If you accept the terms of the License Agreement, click Next, and the Setup Type 
screen appears. If you decline the terms, the installation will terminate.  

 
Setup Type 

4. In the Setup Type screen, select the PaperVision Enterprise Stand-Alone System 
setup type. 

  



Chapter 3 – PaperVision Enterprise Stand-Alone Installation   

PaperVision® Enterprise Installation and Getting Started Guide                                                37 

5. After selecting the setup type, click Next, and the Microsoft® SQL Server® 2005 
Express Edition screen appears.  

 
Microsoft® SQL Server® 2005 Express Edition 

6. If you have already established a database connection, select No, and then proceed to 
step 8 on the next page. 

7. If you would like to install Microsoft SQL Server, select Install Microsoft SQL 
Server 2005 Express Edition, and then click Next to proceed to the next step. 
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8. Click Next and the Ready to Install the Program screen appears. 

 
Ready to Install the Program 
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9. To proceed with the installation, click Install. A progress message will appear for a 
few minutes. 

 
Installing PaperVision Enterprise 
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10. Once PaperVision Enterprise has been successfully installed, the InstallShield 
Wizard Completed screen appears. Click Finish to launch the PaperVision Enterprise 
Configuration Wizard. 

 
InstallShield Wizard Completed 
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Configuring PaperVision Enterprise Stand-Alone 
Once you have successfully installed PaperVision Enterprise Stand-Alone setup type, you are 
presented with a configuration wizard that is designed to simplify the setup process. 

To configure PaperVision Enterprise Stand-Alone: 
1. After you have launched the Configuration Wizard, click Next in the Welcome – 

PaperVision Enterprise Configuration screen. 

 
Welcome – PaperVision Enterprise Configuration 
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2. The Configure PaperVision Automation Service screen appears. The PaperVision 
Automation Service is a Microsoft Windows service that performs automated tasks 
and operations at a specified time interval. Select the user account under which the 
PaperVision Automation Service will execute. 

 
Configure PaperVision Automation Service 

• The Local System Account requires no additional user name or password 
information. However, the Local System Account generally does not have 
access to network shared drives and other directories on the computer. As 
such, it may be necessary to change the account the service is using. A 
confirmation message will prompt you whether to save your changes (if you 
changed the account settings) and continue with the installation.  

Note:  

If you select No, the installation will not proceed. See Appendix C for 
information on changing the Windows service account. 
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• This Account enables you to select the Windows user account that will have 
security rights to perform all PaperVision Automation Service functions such 
as reading, writing, and deleting files. Enter a user name and password, and 
then confirm the password. 

Note:   

The specified account must have the Windows Log On as a Service 
user right enabled. 

3. Verify that the PaperVision Automation Service account settings are correct, and then 
click Next. The Configure PaperVision Client Service Settings screen appears.  

 
Configure PaperVision Client Service Settings 
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4. You must specify the account under which the PaperVision Enterprise Client Service 
will run. First, enter a Port Number that is currently not being used by this machine.  

Note:   
If the port you enter is already in use, an error will appear. For assistance, 
contact your administrator. 

5. Enter the Physical Path, which specifies the directory where the PaperVision 
Enterprise Local Client application files reside. The default location appears in this 
field. If PaperVision Enterprise was installed to another location, click the ellipsis 
button to browse and select that directory.  

6. Enter the Virtual Path, which follows the server or domain name in a web address. 
The default value is the backslash (/) character. For example, in the web address 
http://localhost/PaperVision.aspx, the virtual path, PaperVision.aspx, follows the 
localhost domain name. 

7. If you select the Local System Account, you are not required to configure additional 
settings in this screen. However, the Local System Account generally does not have 
access to network shared drives and other directories on the computer. As such, it may 
be necessary to change the account the service is using. A confirmation message will 
prompt you whether to save your changes (if you changed the account settings) and 
continue with the installation.  

• If you select Yes, proceed to step 9.  

• If you select No, the installation will not proceed.  

Note:  

See Appendix C for information on changing the PaperVision Client Service 
account. 

8. If you selected This Account, enter the user name and password under which the 
PaperVision Enterprise Client Service will execute.  

Note: 
The specified account must have the Windows Log On as a Service user 
right enabled.  

9. If you are prompted to restart the Client Server Settings Windows service, select Yes.  
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10. Click Next, and the PaperVision SQL Server Connection Information screen 
appears. 

 
PaperVision SQL Server Connection Information 

11. Enter the Server IP Address/Name where the database resides.  

12. Enter the Database Name. 

13. Enter the User Name. 

14. Enter the Password, and then confirm the password. 

Note:   

If you leave the User Name and Password fields blank, the database 
connection will use Windows Authentication credentials. Entering a user 
name and password for the database will supercede the Windows 
Authentication credentials. 
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15. Select the Connection Type, which defaults to TCP/IP. Available connection types 
include Named Pipes, IPX/SPX, Multiprotocol, and Banyan Vines. 

16. If you chose the TCP/IP connection, enter the port number. 

17. Select the Create New Database option if the specified database name does not 
already exist. 

18. Select the Create New User option if the specified user name does not already exist. 
If you select this option, the specified user is automatically granted access to the 
database. 

Note:  
If you are creating a new user, you will be prompted to enter the user name 
and password of the account holding permission to create new users. 

19. Click Next, and the PaperVision Licensing screen appears.  

 
PaperVision Licensing 
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20. To add your purchased license, click the Add License button, and proceed to step 22. 

21. If you want to run PaperVision Enterprise in demonstration mode, click the 30 Day 
Demo License button and proceed to step 26 on page 48. 

Note:  

If you have already added a purchased license of PaperVision Enterprise, you 
cannot add a subsequent demo license. If you want to add a demo license, 
you must add it before any purchased license. The demo license includes one 
license each of the Advanced Admin Pack and Enterprise Workflow and fifty 
Enterprise User licenses. 

22. In the New License dialog box, enter the license code that was included with your 
product documentation and media.  

23. If the computer has access to the Internet, click the Web Authorization button to 
obtain the license key online.  

24. Or, click the Phone Authorization button and contact Digitech Systems’ Technical 
Support toll-free at (877)374-3569 or direct at (402)484-7777 to obtain your license 
key.  

Note:  

You must provide the serial number and identifier before the license key will 
be provided to you.  

25. In the Obtain Authorization Code dialog box, enter the code, and then click OK. 
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26. Click Next, and the PaperVision Data Storage screen appears.  

 
PaperVision Data Storage 

27. In the PaperVision Data Storage screen, enter the location of the data storage path 
where document and full-text data will be stored, or click the ellipsis button to browse 
to the location. If multiple computers will be accessing this location, it is 
recommended to enter a network-accessible path such as \\SERVER\SHARE. 
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28. Click Next, and the Thank You – PaperVision Enterprise Configuration screen 
appears.  

 
Thank You – PaperVision Enterprise Configuration 

29. Click Finish to close the configuration wizard. You are ready to log into the 
PaperVision Enterprise application. 
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Uninstalling PaperVision Enterprise 
This operation will remove PaperVision Enterprise from the system. However, user-generated 
data, including processed files, databases, images, etc. will remain intact.  

To uninstall PaperVision Enterprise: 
1. Open the Windows Control Panel. 

2. Select the Add/Remove Programs applet. 

3. Select PaperVision Enterprise and click Add/Remove. 
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After PaperVision Enterprise has been successfully installed and before users can  
begin working with the software, a global administrator must complete several  
tasks within the PaperVision Administration Console, such as creating an entity (with 
associated projects) and adding new PaperVision Enterprise users. Additionally, several 
global administration operations, such as configuring system settings and Automation Service 
Scheduling operations, must be performed by a global administrator. Entity and project 
configuration, global administration operations, and all other administration functions are 
described in the accompanying PaperVision Enterprise Administration and System 
Architecture Reference Guide.  
 
PaperVision Enterprise Configuration Utility 
After installation, if you need to reconfigure any component of PaperVision Enterprise such 
as the PaperVision Automation Service, SQL Server connection, or Client Server settings, 
you can use the PaperVision Enterprise Configuration Utility. To open the tool, open Start > 
Programs > Digitech Systems > PaperVision Enterprise Configuration Utility.  

 
PaperVision Enterprise Configuration Utility
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The following table describes the settings available for reconfiguration in each screen of the 
PaperVision Enterprise Configuration Utility. After you complete your changes in each 
screen, click Save, and then click Exit. 

Configuration Utility Screen Settings Available for Reconfiguration 
Configure PaperVision 
Automation Service 

Account under which the PaperVision Enterprise 
Automation Service will run, including User 
Name and Password  

Client Server Settings Client Server Settings, including Port Number, 
Physical and Virtual Paths 

SQL Server Connection 
Information 

SQL Server Connection Information, including 
Server IP/Name, Database Name, User Name, 
Password, Connection Type, and TCP/IP Port 
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Launching the PaperVision Administration Console 
The PaperVision Administration Console provides a single point of administration for 
everything related to PaperVision Enterprise, including workflow configuration. The tool can 
manage an unlimited number of entities from a single sign-on. Only global administrators, 
system administrators, and workflow administrators can log into the administration console.  

To launch the PaperVision Administration Console for the first time, double-click the 
PaperVision Admin Console icon on the desktop, or select Start > Programs > Digitech 
Systems > PaperVision Admin Console. Log in using the default user name (ADMIN) and 
password (ADMIN) for the system administrator. Selecting the Global checkbox determines 
whether you are logging in as a global or system administrator. Initially, log in as a global 
administrator.  

Since you have already configured PaperVision Enterprise in the Configuration Wizard, you 
are initially presented with the main Administration Console screen. Documentation 
describing the features and functionality of the PaperVision Administration Console, 
including global administration, is found in the accompanying PaperVision Enterprise 
Administration and System Architecture Reference Guide.  
 

 
PaperVision Administration Console 
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Launching the PaperVision Enterprise Web Client 
The PaperVision Enterprise Web Client is accessed through your web browser, and includes 
all client functionality and operations such as document viewing, searching, indexing, and 
other document manipulation operations. When you initially log into the Web Client 
application, you must change your current password. 

To launch the Web Client: 
1. Launch your web browser.  

2. In your browser’s address bar, type in the PaperVision Enterprise URL provided by 
your administrator, which follows the general format: 

http://<pveurladdress>/default.aspx 

The Login prompt appears. 

 
Login Prompt  
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3. Type your user name and password, and then click Login. The Password Change 
Required prompt appears.  

 
Password Change Required 

4. Enter your current password. 

5. Enter and confirm your new password.  

6. Click Change (or, press Enter). The main PaperVision Enterprise screen appears, 
displaying the directories containing your projects, worksteps, destruction lists, 
system settings, etc. Documentation describing the features and functionality of the 
PaperVision Enterprise Web Client is found in the accompanying PaperVision 
Enterprise User Guide. 
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The following multi-purpose internet mail extensions (MIME) are supported by  
PaperVision Enterprise. Each Microsoft Office 2007 MIME type listed below  
follows the general format “application/octet stream.” 
 

.xlsx 
application/vnd.openxmlformats-officedocument.spreadsheetml.sheet 
 

.xltx 
application/vnd.openxmlformats-officedocument.spreadsheetml.template 
 

.potx 
application/vnd.openxmlformats-officedocument.presentationml.template 
 

.ppsx 
application/vnd.openxmlformats-officedocument.presentationml.slideshow 
 

.pptx 
application/vnd.openxmlformats-officedocument.presentationml.presentation 
 

.sldx 
application/vnd.openxmlformats-officedocument.presentationml.slide 
 

.docx 
application/vnd.openxmlformats-officedocument.wordprocessingml.document 
 

.dotx 
application/vnd.openxmlformats-officedocument.wordprocessingml.template 

 

.xlam 

application/vnd.ms-excel.addin.macroEnabled.12 

 

.xlsb 
application/vnd.ms-excel.sheet.binary.macroEnabled.12
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PaperVision Enterprise offers the ability to have web servers redirect their 
processing to separate application servers with PaperVision Enterprise installed  
on them. Configuring a web server to use a separate application server is as easy as 
creating/modifying a single file on the web server. To do this, create a PVDM.ini in the 
Program Files\Digitech Systems\Common Files\ directory. 
 

Insert the following two lines of text: 
[PVDM] 

REDIRECTREQ=http://yourappserverhere/ 

If your web server sits behind a load balancer or is being accessed via non-standard ports, you 
should also add the following lines: 

[PVDM-GLOBALSYSTEM] 

WEBURL=http://yourwebserverhere/ 

Or, you can insert the following lines of text with a non-standard port number (in this 
example, 676): 

[PVDM-GLOBALSYSTEM] 

WEBURL=http://yourwebserverhere:676/ 

Note:  

Alternatively, these URL addresses can contain the “https” protocol identifier.  

If your web server will redirect to another web server (not just another application server), 
you should add the following line to the [PVDM]section of the file: 

REDIRECTWEBFILEOPS=1 

Since the web server will never need to interact with the database, it is not necessary (nor 
recommended for security reasons) to start the PaperVision Administration Console and 
connect to a database on the web server. 
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The PaperVision Automation Service and PaperVision Client Service automate 
tasks that require no human intervention. Both services run as true Windows  
services and are started automatically the first time the PaperVision Administration  
Console is launched. Since both are running as true services, no user must be logged into the 
computer in order for both to perform their respective processing. By default, they are 
configured to run under the Local System account. These accounts generally do not have 
access to network shares as well as a number of directories on the computer. As such, it may 
be necessary to change the account each service is using. 
 
To change the Windows Service account: 

1. Right-click My Computer, and select Manage. The Computer Management 
screen appears. 

 
Computer Management 
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2. Select Services and Applications > Services. 

Note:  

For Microsoft Windows Server 2008, select Configuration > Services). 

 

 
Computer Management – Services and Applications 
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3. Scroll down through the list of services, and select the PaperVision Automation 
Server (or PaperVision Client Service). In this example, the PaperVision 
Automation Server Properties – General screen appears. 

 
PaperVision Automation Server Properties – General 
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4. Select the Log On tab. The PaperVision Automation Server Properties – Log 
On screen appears. 

 
PaperVision Automation Server Properties – Log On 

5. Select This account. 

6. Select the Browse button and choose a user account that has the necessary 
permissions. 

7. Enter the user account’s password. 

8. Re-enter the user account’s password. 

9. Click OK to apply the changes. Windows will configure the service and account 
appropriately. 

10. Select the General tab. 

11. Click Stop to stop the service. 

12. Click Start to restart the service. 

13.  Click OK.
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PaperVision Enterprise provides the ability to support multiple entities. By  
default, all users will log into the default entity (Entity ID 1). However, if you  
wish to enable the ability to use multiple entities, users will need the ability to  
provide their Entity ID when they log into PaperVision Enterprise. 
 
To enable multiple entity login for the PaperVision Administration Console: 

1. Locate the PVDM.INI file in the Digitech Systems\Common Files\ directory where 
PaperVision Enterprise was installed. 

2. In that file, insert the following lines of text: 

[PVDM] 
LOGINENTID=1 

Note:  

The [PVDM]section may already exist. 

3. Save the file. 

The next time the PaperVision Administration Console is launched, the user will be prompted 
to provide the Entity ID. Providing an Entity ID of zero (0) will cause PaperVision 
Administration Console to attempt to log a user in as a global administrator. Zero is not valid 
for the PaperVision Enterprise application because global administrators cannot access 
documents. 

 

To enable multiple entity login for the PaperVision Enterprise Web Client: 
1. Locate the global_en.resx file in the PaperVision\PVEWeb\App_GlobalResources 

directory where PaperVision Enterprise was installed, and open it with a text editor. 

2. In that file, change the “false” constant in the following line to “true”: 
<data name=”gblLoginShowEntID” xml:space=”preserve”> 
<value>true</value> 
 

3. Save the file. Upon the next login, the user will be prompted to provide an Entity ID. 

Note:   

Alternatively, you can show (or hide) your entity ID in the user Login 
window by modifying the Web Client option in System Settings > User 
Options > Display Settings > Display Entity ID or Hide Entity ID. 
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 WARNING!  

Modifying settings within any operating system may adversely affect 
overall system performance. If you are unsure of the potential 
consequences resulting from modifying Data Execution Prevention 
(DEP) settings, please contact your IT department before proceeding 
with the following instructions. Changing the following DEP settings 
will not provide any DEP coverage for any part of your operating 
system, regardless of hardware DEP support.  

 
Microsoft Windows XP SP2 uses a set of hardware- and software-based technologies called 
Data Execution Prevention (DEP) to prevent malicious code from being inserted into areas of 
computer memory reserved for non-executable code. As a result, DEP may prevent certain 
operations from executing properly in PaperVision Enterprise. 

To modify Windows XP DEP settings: 
1. Log into your computer using an account with local Administrator rights. 

2. Right-click on My Computer and select Properties.  

3. Click the Advanced tab.  
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4. In the Startup and Recovery section, click the Settings button. The Startup and 
Recovery dialog box appears. 

 
Startup and Recovery 

5. In the System startup section, click the Edit button. The Boot.ini file opens in the 
default text editor. 

6. Locate the text “/noexecute=OptIn.” 

7. Change the OptIn value to “AlwaysOff.” The text now appears as 
“:/noexecute=AlwaysOff.” 

WARNING! 

Enter the specified text exactly as it appears in the preceding steps. If the text is 
altered, your computer may not reboot.   

8. Select File > Save.  

9. Click OK to close the Startup and Recovery window.  
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10. Click OK to close the System Properties windows. 

11. Restart your computer.  
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The PaperVision Enterprise Installation and Configuration Wizard automatically  
configures the PaperVision Enterprise and PaperVision Authentication Gateway  
web sites within IIS. This appendix is provided as a reference in case you need to  
modify IIS 6.0 or 7.0 settings at a later time. If you intend to use this computer as a 
PaperVision.net Enterprise web server or a PaperVision Enterprise application server, you 
must configure Microsoft’s Internet Information Server (IIS) to use the PaperVision.net 
Enterprise ASP and ASPX pages. 
 

Security Considerations 
IIS allows configuration of the user account that will be used when a user is anonymously 
connected to the PaperVision.net Enterprise web site. It is important that the user account 
(usually named IUSR_SERVERNAME) has the following NTFS directory permissions in 
order for PaperVision.net to operate properly: 

• Full access to the <Program Files>\Digitech Systems directory 

• Read and Execute access to the PaperVision.net Enterprise web server directory where 
you selected to install PaperVision Enterprise 

• Full access to the PaperVision Enterprise cache directory (WebServer\Cache) 

• Full access to the directory where PaperVision data will reside 

• Full access to any jukeboxes or any other directories where images (i.e. data 
groups/CDs) reside 

 
Since the default account does not have these permissions, you must manually assign them to 
the user account or select a user account that already has the permissions. In the configuration 
example presented, selecting a different user account will be demonstrated. 
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Configuring IIS 6.0 
IIS 6.0 is the version of IIS that is included with Microsoft Windows Server 2003 and some 
versions of Microsoft Windows XP. This section assumes that Microsoft IIS is already 
installed on your computer with the ASP.NET and Active Server Pages components. 

 
To configure Microsoft Windows Server 2003’s IIS 6.0 for use with PaperVision 
Enterprise: 

1. From the Start menu, select Programs > Administrative Tools – Internet 
Information Services (IIS) Manager. The IIS Management Console will be started.  

Note:  

It is recommended that you stop (and possibly delete) the default web site and 
default FTP site if you do not plan on using those. 

 
IIS Management Console 
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2. Expand your server and select Web Service Extensions. The Web Service 
Extensions screen is displayed. 

 
Web Service Extensions 

3. PaperVision Enterprise utilizes both ASP (Active Server Pages) and ASP.NET. 
Ensure that both Active Server Pages and ASP.NET v2.0.50727 are Allowed. 
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4. Right click on Web Sites and select New > Web Site from the menu. The Web Site 
Creation Wizard screen is displayed. 

 
Web Site Creation Wizard 
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5. Select Next. The Web Site Description screen is displayed. 

 
Web Site Description 
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6. Enter the name or description of the new site, and then click Next. The IP Address 
and Port Settings screen is displayed. 

 
IP Address and Port Settings 
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7. From the drop-down list, select the IP Address to be used by the new site, and then 
click Next. The Web Site Home Directory screen is displayed. 

 
Web Site Home Directory 

8. Select the Browse button to locate the PVEWeb directory where the PaperVision 
Enterprise web server was installed. 
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9. Click Next. The Web Site Access Permissions screen is displayed. 

 
Web Site Access Permissions 
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10. Ensure that only Read and Run scripts are selected, and then click Next. The Web 
Site Wizard Completed screen is displayed. 

 
Web Site Wizard Completed 
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11. Select Finish to complete the wizard. The new site will be created and listed under 
your server as shown below. 

 
Web Site Created 
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12. After the site has been created, configuration settings for the Anonymous Access 
user account will be changed. Right-click on the newly-created web site, and select 
Properties. The Web Site Properties – Web Site screen is displayed. 

 
Web Site Properties – Web Site 
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13. Select the Directory Security tab. The Web Site Properties – Directory Security 
screen is displayed. 

 
Web Site Properties – Directory Security 
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14. Under Authentication and access control, select the Edit button. The 
Authentication Methods screen is displayed. 

 
Authentication Methods 

15. Ensure that Enable Anonymous access is selected, and then choose Browse. The 
Select User screen is displayed. 

 
Select User 
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16. Select a user that has the appropriate permissions, and then click OK. The selected 
user account is now displayed in the Authentication Methods screen. 

17. Enter the user’s password. 

18. Remove any Authenticated access methods (i.e., Integrated Windows authentication). 
The Authentication Methods screen is displayed. 

 
Authentication Methods 

19. Click OK, and the Confirm Password prompt appears. 

 
Confirm Password 
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20. Re-enter the password, and then click OK. The Web Site Properties – Directory 
Security screen is displayed. 

21. Select the HTTP Headers tab. The Web Site Properties – HTTP Headers screen is 
displayed.  

 
Web Site Properties – HTTP Headers 

IIS 6.0 has a security feature that only allows requests for known file extensions. Under 
normal environments, this is a very good security feature to have. However, in a document 
management system, the documents that are served up may have any file extension. 
Additionally, PaperVision Enterprise uses unique file extensions for full-text data and 
document annotations that essentially require the disabling of this security setting.  
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22. Select the MIME Types button. The MIME Types screen appears. 

 
MIME Types 

23. Select New, and the MIME Type screen is displayed. 

 
MIME Type 

24. Enter an asterisk (“*”) for the Extension. 
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25. Enter “application/octet-stream” for the MIME type, and then select OK. The new 
entry is added to the MIME Types screen. 

 
MIME Types 
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26. Select OK to close the MIME Types screen. The Web Site Properties – HTTP 
Headers screen is displayed. 

27. Select the Home Directory tab. The Web Site Properties – Home Directory screen 
is displayed. 

 
Web Site Properties – Home Directory 

28. Select the Configuration button. The Application Configuration - Mappings 
screen is displayed. 
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29. Select the Options tab. The Application Configuration – Options screen is 
displayed. 

 
Application Configuration - Options 

30. PaperVision.net Enterprise does not make use of IIS session state. This greatly 
enhances the performance of the PaperVision.net Enterprise application. As such, 
uncheck Enable session state. 

31. PaperVision.net Enterprise uses IIS parent paths, so select Enable parent paths. 

32. When a user executes a function that takes a considerable amount of time (i.e. 
running large reports), it can often exceed the default ASP script timeout. As such, 
you may want to enter a larger ASP script timeout value. 
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Application Configuration – Options (configured) 

33. Select OK to save your Application Configuration settings. 

34. Select OK to save the site properties. 

 

Now that IIS is configured you must decide whether to use process redirection (as described 
in Appendix B – Setting Up Process Redirection). If you decide not to use process 
redirection, you will have to configure the system settings as described in the chapter Global 
Administration in the accompanying PaperVision Enterprise Administration and System 
Architecture Reference Guide.  
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Configuring IIS 7.0 
IIS 7.0 is the version of IIS that is included with Microsoft Windows Server 2008 and 
Microsoft Windows Vista. In Microsoft Windows Server 2008, it is highly recommended that 
you add the following two server roles if they have not already been added: 

• Application Server 

• Web Server (IIS) 

Additionally, when selecting the role services for the “Web Server (IIS)” role, be sure to add 
the following role services (in addition to the defaults): 

• ASP.NET 

• ASP 

• Windows Authentication (if using the PaperVision Authentication Gateway as 
described in Appendix G – Remote Authentication) 
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To configure Microsoft Windows Server 2008’s IIS 7.0 for use with PaperVision 
Enterprise: 

1. From the Start menu, select Programs > Administrative Tools > Internet 
Information Services (IIS) Manager. The IIS Manager will be started.  

Note:  

It is recommended that you stop (and possibly delete) the default web site if 
you do not plan on using it. 

 
IIS Manager 
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2. Right click on your server and select Add Web Site. The Add Web Site screen is 
displayed. 

 
Add Web Site 

3. Enter a Site name. Note than an associated Application Pool is automatically created 
with the same name. It is strongly suggested that you use this newly created 
application pool. 

4. Select the ellipsis button next to the Physical Path field and choose the PVEWeb 
directory where the PaperVision Enterprise web server was installed. 
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5. Select the IP Address to be used by the new site. 

 
Add Web Site (Configured) 
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6. Select OK. The new site will be created and listed under your server as shown below. 

 
Web Site Created 
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7. After the site has been created, several configuration settings must be made to the 
Anonymous Access user account as described earlier. Under the IIS section, double 
click ASP. The ASP Properties screen is displayed. 

 
ASP Properties 

8. Expand Session Properties. 
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9. PaperVision.net Enterprise does not make use of IIS session state. This greatly 
enhances the performance of the PaperVision.net Enterprise application. As such, set 
Enable Session State to a value of False as shown below. 

 
ASP Properties (Enable Session State – False) 

10. Click the Apply link (top, right corner of the IIS Manager). 

11. Click your site in the left pane to display the configuration options again. 
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12. Under the IIS section, double click on Authentication. The Authentication 
Properties screen is displayed. 

 
Authentication Properties 

13. Highlight Anonymous Authentication and click the Edit link (top, right corner of 
the IIS Manager). The Edit Anonymous Authentication Credentials screen is 
displayed. 

 
Edit Anonymous Authentication Credentials 

14. Select Application pool identity and click OK. 
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15. To configure the appropriate user in the Application Pool’s properties, select 
Application Pools. The Application Pools screen is displayed. 

 
Application Pools 
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16. Right-click on the application pool used by your site (typically the same name as your 
site) and choose Advanced Settings. The Application Pool – Advanced Settings 
screen is displayed. 

 
Application Pool – Advanced Settings 
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17. Under Process Model > Identity, click the ellipsis button. The Application Pool 
Identity screen is displayed. 

 
Application Pool Identity 

18. Select Custom account, and then click Set. The Set Credentials screen is displayed. 

 
Set Credentials 

19. Enter the User Name and Password (with a confirmed password) of the account 
discussed in the Security Considerations section at the beginning of this appendix, 
and then click OK. 

20. Click OK to save the Application Pool Identity settings. 

21. If you are running PaperVision Enterprise on a 64-bit operating system, set the 
General – Enable 32-Bit Applications value to True.  

Note:  

This setting is only available on 64-bit operating systems. 

22. Click OK to save the Application Pool Advanced Settings. 
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23. Recycle (stop and restart) the application pool by selecting the Recycle link (top, 
right corner of the IIS Manager). 

24. Now that IIS is configured you must decide whether to use process redirection (as 
described in Appendix B). If you decide not to use process redirection, you will have 
to configure the system settings as described in the Global Administration chapter in 
the accompanying PaperVision Enterprise Administration and System 
Architecture Reference Guide. 
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PaperVision Enterprise includes remote authentication gateway capabilities  
that allow organizations to integrate Windows authentication/single sign-on in  
a secure manner, regardless of whether the PaperVision repository is located in the same 
Active Directory domain as the authenticated users. Additionally, it allows users to access 
their repository both from within their Active Directory domain and external to that domain, 
when Windows authentication/single sign-on is unavailable. This is accomplished as follows: 

1. The user opens the web browser and points it to the installed “PaperVision 
Authentication Gateway” server’s web site. This “PaperVision Authentication 
Gateway” IIS web site installation must have the ability to authenticate the user 
against Active Directory. 

2. The authentication gateway reads an encrypted configuration file which indicates the 
encryption key value that will be used to encrypt the user’s credentials. By using the 
security context that IIS is running under, the gateway determines the user’s domain 
name and user name (i.e. DOMAIN\USER). It then encrypts this as the PaperVision 
user name using the specified encryption key value. 

3. The gateway then redirects the user’s browser to their standard PaperVision 
repository’s login page (locally within the same domain, or remotely), passing the 
encrypted login credentials. 

4. The PaperVision login process automatically detects that remotely authenticated 
credentials have been passed. As such, it uses the entity security policy’s Remote 
Authentication Gateway Encryption Key value (note – the value is used, not the 
name) to decrypt the authenticated credentials. If the credentials have not been 
encrypted with the specified encryption key value, they will not be able to be 
decrypted and the user will not be automatically authenticated to the repository. If the 
credentials are properly encrypted (and hence, can be decrypted), the user is 
automatically logged in. 

It is the common Remote Authentication Gateway Encryption Key value between the 
authentication gateway and the PaperVision repository that ensures only authorized 
authentication gateways may pass credentials. It is important to note that PaperVision has no 
visibility into a user’s Active Directory password. As such, it is neither necessary nor 
recommended to maintain consistent passwords between PaperVision and Active Directory 
for a user. 
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Remote Authentication Use Scenarios 
PaperVision’s remote authentication gateway facilities are designed to be used in nearly any 
environment. Below are three likely scenarios and their general installation steps. 

 

PaperVision Repository within Same Active Directory Domain 
In this scenario, the PaperVision Enterprise server is installed as a member of the users’ 
Active Directory domain. Although the easiest way of accomplishing this is to simply use 
the AutoLogin.ASPX page that is installed in the WebServer directory, doing so requires 
using Authenticated Access in the web site under which PaperVision Enterprise is running. 
The primary problem with this is that all activities performed by the server (i.e. database 
and file access) are performed using the user’s Active Directory credentials. As such, each 
user would have to be given explicit security access to the document storage 
shares/locations and the database server. A much better manner of handling this situation is 
to simply setup two different web sites on the same computer (typically requiring an IP 
address for each site). This allows the server’s activities to be performed under a single 
security context (when the primary web site is hit), while still allowing the user’s security 
context to be determined by the authentication gateway web site. The general installation 
steps for configuring this scenario are as follows: 

1. Install and configure the PaperVision Enterprise server as normal (including 
making the necessary IIS configuration settings) on a server located in the Active 
Directory domain. Additional information pertaining to this can be found in 
Chapter 2, PaperVision Enterprise Server Installation. However, when 
installing PaperVision, perform a Custom installation and add the “PaperVision 
Authentication Gateway” feature.  

2. Configure a second IIS web site on this server for the PaperVision Authentication 
Gateway as described later in this appendix. 

3. Using the PaperVision Administration Console, configure a new encryption key 
and then select that encryption key in the entity security policy’s Remote 
Authentication Gateway Encryption – Key Name setting (located in the 
Authentication tab). 

4. Run and configure the PaperVision Gateway Settings application as described at 
the end of Chapter 2, PaperVision Enterprise Server Installation. 
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PaperVision Repository within a Different Active Directory Domain 
In this scenario, the PaperVision server is installed in either a different Active Directory 
domain (or no domain at all) as the users’ Active Directory domain (i.e. PaperVision web 
server is located in the DMZ which doesn’t have a trust relationship with the 
organization’s internal domain). The general installation steps for configuring this scenario 
are as follows: 

1. On a server within the user’s Active Directory domain, install only the 
PaperVision Authentication Gateway. This is accomplished by performing a 
Custom installation and selecting ONLY the following features: 

• PaperVision Enterprise COM API 

• PaperVision Enterprise Server 

• PaperVision Authentication Gateway 

2. Configure an IIS web site on this server for the PaperVision Authentication 
Gateway as described later in this appendix. 

3. Using the PaperVision Administration Console, configure a new encryption key 
and then select that encryption key in the entity security policy’s Remote 
Authentication Gateway Encryption – Key Name setting (located in the 
Authentication tab). 

4. Run and configure the PaperVision Gateway Settings application as described at 
the end of Chapter 2, PaperVision Enterprise Server Installation. 

 

PaperVision Repository Provided by ImageSilo 
In this scenario, the PaperVision repository is located on a completely separate network, 
with absolutely no visibility into the users’ Active Directory. The general installation steps 
for configuring this scenario are identical to those described above for PaperVision 
Repository within a Different Active Directory Domain. 
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Configuring the Authentication Gateway Web Site in IIS 6.0 
In order to use the PaperVision Authentication Gateway, you must configure Microsoft’s 
Internet Information Server (IIS) to use the PaperVision Authentication Gateway ASPX 
page(s). IIS 6.0 is the version of IIS that is included with Microsoft Windows Server 2003 and 
some versions of Microsoft Windows XP. This section assumes that Microsoft IIS is already 
installed on your computer with the ASP.NET and Active Server Pages components. 

To configure the PaperVision Authentication Gateway web site in Microsoft 
Windows Server 2003’s IIS 6.0: 

1. From the Start menu, select Programs > Administrative Tools > Internet > 
Information Services (IIS) Manager. The IIS Management Console will be started.  

Note:  

It is recommended that you stop (and possibly delete) the default web site and 
default FTP site if you do not plan on using those. 

 

 
IIS Management Console 
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2. Expand your server and select Web Service Extensions. The Web Service 
Extensions screen is displayed. 

 
Web Service Extensions 

3. PaperVision Enterprise utilizes both ASP (Active Server Pages) and ASP.NET. 
Ensure that both Active Server Pages and ASP.NET v2.0.50727 are both Allowed. 
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4. Right-click on Web Sites and select New > Web Site from the menu. The Web Site 
Creation Wizard screen is displayed. 

 
Web Site Creation Wizard 
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5. Select Next. The Web Site Description screen is displayed. 

 
Web Site Description 
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6. Enter the name or description of the new site and click Next. The IP Address and 
Port Settings screen is displayed. 

 
IP Address and Port Settings 
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7. Select the IP address from the drop-down list and click Next. The Web Site Home 
Directory screen is displayed. 

 
Web Site Home Directory 
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8. Browse to the PVEWebAuthGW directory where the PaperVision Enterprise 
Authentication Gateway was installed, and then click Next. The Web Site Access 
Permissions screen is displayed. 

 
Web Site Access Permissions 
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9. Ensure that only Read and Run scripts are selected and click Next. The Web Site 
Wizard Completed screen is displayed. 

 
Web Site Wizard Completed 
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10. Select Finish to complete the wizard. The new site will be created and listed under 
your server as shown below. 

 
Web Site Created 
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11. The authentication method and other configuration settings must be changed. Right-
click on the newly-created web site and select Properties. The Web Site Properties 
– Web Site screen is displayed. 

 
Web Site Properties – Web Site 

  



 Appendix G – Remote Authentication  

PaperVision® Enterprise Installation and Getting Started Guide                                              111 

12. Select the Directory Security tab, and the Web Site Properties – Directory 
Security screen is displayed. 

 
Web Site Properties – Directory Security 
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13. Under Authentication and access control, select the Edit button. The Authentication 
Methods screen is displayed. 

 
       Authentication Methods 

  



 Appendix G – Remote Authentication  

PaperVision® Enterprise Installation and Getting Started Guide                                              113 

14. Disable Anonymous access, and enable Integrated Windows authentication as 
shown below: 

 
Authentication Methods (configured) 

 
15. Select OK, and the Web Site Properties – Directory Security screen is displayed. 
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16. Select the Home Directory tab. The Web Site Properties – Home Directory screen 
is displayed. 

 
Web Site Properties – Home Directory 
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17. Select the Configuration button. The Application Configuration - Mappings 
screen is displayed. 

18. Select the Options tab. The Application Configuration – Options screen is 
displayed. 

 
Application Configuration – Options 

19. PaperVision.net Enterprise does not make use of IIS session state. This greatly 
enhances the performance of the PaperVision.net Enterprise application. As such, 
disable the Enable session state option. 

20. PaperVision.net Enterprise uses IIS parent paths, so select Enable parent paths. 
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21. When a user executes a function that takes a considerable amount of time (i.e. 
running large reports), it can often exceed the default ASP script timeout. As such, 
you may want to enter a larger ASP script timeout value. 

 
Application Configuration – Options (configured) 

22. Select OK to save your Application Configuration Options. 

23. Select OK to save the site properties. 
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Configuring the Authentication Gateway Web Site in IIS 7.0 
In order to use the PaperVision Authentication Gateway, you must configure Microsoft’s 
Internet Information Server (IIS) to use the PaperVision Authentication Gateway ASPX 
page(s). IIS version 7.0 is included with Microsoft Windows Server 2008 and Microsoft 
Windows Vista. In Microsoft Windows Server 2008, it is highly recommended that you add 
the following two server roles if they have not already been added: 

• Application Server 

• Web Server (IIS) 

Additionally, when selecting the role services for the “Web Server (IIS)” role, be sure to add 
the following role services (in addition to the defaults): 

• ASP.NET 

• ASP 

• Windows Authentication 
 

To configure the PaperVision Authentication Gateway web site in Microsoft 
Windows Server 2008’s IIS 7.0: 

1. From the Start menu, select Programs > Administrative Tools > Internet 
Information Services (IIS) Manager. The IIS Manager will be started. 

 
IIS Manager 
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2. Right click on your server, and select Add Web Site. The Add Web Site screen is 
displayed. 

 
Add Web Site 

3. Enter the Site name. Note that an associated Application Pool is automatically created 
with the same name. It is strongly suggested that you use this newly-created 
application pool. 

4. To the right of the Physical path, click the ellipsis button to select the 
PVEWebAuthGW directory where the PaperVision Enterprise web server was 
installed. 
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5. Select the IP address to be used by the new site.  

 
Add Web Site (configured) 
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6. Select OK, and the new site will be created and listed under your server as shown 
below. 

 
Web Site Created 
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7. Next, some configuration settings need to be changed. Under the IIS section, double 
click on ASP. The ASP Properties screen is displayed. 

 
ASP Properties 

8. Expand Session Properties. 
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9. PaperVision.net Enterprise does not make use of IIS session state. This greatly 
enhances the performance of the PaperVision.net Enterprise application. As such, set 
Enable Session State to a value of False. 

 
ASP Properties – Enable Session State (False) 

10. Click the Apply link (top, right corner of the IIS Manager). 

11. Click your site in the left pane to display the configuration options again. 
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12. Under the IIS section, double click on Authentication. The Authentication 
Properties screen is displayed. 

 
Authentication Properties 

13. Highlight Anonymous Authentication and click the Disable link (top, right corner of 
the IIS Manager). 

14. Highlight Windows Authentication and click the Enable link (top, right corner of the 
IIS Manager). 
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15. The authentication settings in the Application Pool’s properties must be configured. 
Select Application Pools. The Application Pools screen is displayed. 

 
Application Pools 
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16. Right-click on the application pool used by your site (typically the same name as your 
site) and choose Advanced Settings. The Application Pool – Advanced Settings 
screen is displayed. 

 
Application Pool – Advanced Settings 
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17. Under Process Model > Identity, click the ellipsis button. The Application Pool 
Identity screen is displayed. 

 
Application Pool Identity 

18. Select Custom account and click the Set button. The Set Credentials screen is 
displayed. 

 
Set Credentials 

19. Enter the User name and Password (with a confirmed password) of the account 
discussed in the Security Considerations section at the beginning of Appendix F, 
and then click OK. 

20. Click OK to save the Application Pool Identity settings. 
21. If you are running PaperVision Enterprise on a 64-bit operating system, set the 

General – Enable 32-Bit Applications value to True.  

Note:   

This setting is only available on 64-bit operating systems. 

22. Click OK to save the Application Pool Advanced Settings. 

23. Recycle (stop and restart) the application pool by selecting the Recycle link (in the 
top, right corner of the IIS Manager.
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